Seniorin digitaidot:
Sahkopostin peruskayttotaidot

Bert Bjarland, syksy 2020




Jos epaselvaa, huomautettavaa, kysyttavaa?

* Keskeyta tai nosta kasi

* Raise Hand-toiminnolla =y,
« fyysisesti (mutta kameran » Klikkaa Participants-ikonia nayttosi

edess3, ettd nakyy): alalaidassa, keskella. Oikealle avautuvassa

osallistujaikkunassa, klikkaa Raise Hand
* Digitaalinen katesi on nyt pystyssa.

, Tilaisuuden hostaaja reagoi siihen ja antaa
sinulle puheenvuoron. Kaden saat alas
klikkaamalla Lower Hand

* Vaihtoehtoisesti voit kirjoittaa kysymyksesi
| Chat-ikkunaan, jonka ikoni myos nayttosi

| alalaidassa.
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Sahkoposti ?

* Tietokoneen tai dlypuhelimen avulla toimiva nopea viestikanava, joka
*internetin kautta

e valittaa digitaalisia viesteja
(SMTP- seka POP3-, IMAP- tai HTTP-protokollalla)
* [ahettajalta yhdelle tai useammalle vastaanottajalle, joilla

* sahkopostiosoite

enter




Sahkopostiosoite ?

» Sahkopostiosoite on tunnuksesi cyberavaruudessa / internetissa ja on
muotoa
tunnus@verkkotunnus

* jossa tunnus on usein muotoa
nimi tai etunimi.sukunimi

* ja verkkotunnus useimmiten ilmoittaa sahképostin palveluntarjoajasi, esim
gmail.com

* Pekka Puupadan sahkopostiosoite voisi ndin olla esim

pekka.puupaa@gmail.com

enter




Verkkotunnus (domain)

* Poimintoja sahkopostisovellukseni Address Bookista:
gmail.com, kaapeli.fi, adlibris.com, yahoo.com, turku.fi, seta.fi,
helsinki.fi, hanken.fi, iki.fi, pp.inet.fi, amnesty.fi, monikanaiset.fi,
abo.fi, kolumbus.fi, vaestoliitto.fi, eduskunta.fi, yle.fi, helka.net, utu.fi,
ollus.net, luukku.com, naisjarjestot.fi, stm.fi, hel.fi, netti.fi, redcross.fi,
reform.no, welho.com, elisanet.fi, aware.org.sg, aland.net,
icloud.com, sfp.fi, klockrike.fi, konstsalongen.com, nordea.fi, om.fi,
klarna.fi, posti.com, hbl.fi, easypark.net, hot.ee, viirus.fi, nytid.fi,
outlook.com, ficora.fi, aalto.fi, espoo.fi, thl.fi, telia.fi, dentti.fi,
arkadiabookshop.fi, entersenior.fi, hattulanpuu.fi, krut.fi, vtt.fi, ..
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Sahkopostin kaytto, Windows
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Sahkopostin kaytto, Android-kannykka

e Kdnnykassa on valmistajasta
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Sahkopostin hallinta

* Postilaatikkoon on valitettavan helppo hukkua. Mita enemman
postilaatikossa on viesteja, sita vaikeampi niita on hallita.
Ratkaisuja:

* Kansioita; esim. Thunderbirdissa voi luoda kansioita ja siirtaa kaikki luetut ja
toimenpiteita vaatineet viestit niihin

* Hakukoneen kayttd; esim. Gmailissa on tehokas hakukone — jos vain muistaa
milla hakusanalla pitaisi hakea

* Kaikki viestit jotka eivat SPAM-filtterin kautta automaattisesti ohjaudu
SPAM-kansioon, jotka eivat vaadi toimenpiteita tai joilla ei ole tunne- tai
muuta arvoa, kannattaa saannollisesti poistaa
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Ja nyt: Tarkistuslista

* 14 kysymysta sahkopostin
e kayttdoonottamisesta,
e kayttamisesta,
* hallinnasta ja
e turvallisuudesta

* oman taidon arvioimiseksi, seka
* lisdopiskeluun innoittamiseksi

enter




1 Osaan luoda sahkopostitilin

* Osaan valita palveluntarjoajan

/

(esim. Gmailille Google)
1

https://accounts.google.com/signup/

* Osaan luoda siella tilin

(syottaa nimi, sahkopostiosoite,
valitsemani salasana kahteen
kertaan seka kannyyn vastaan-
otettava todentamiskoodi)

enter

Google

Create your Google Account
First name Last name
JSEINaMme @gmail.com

You can use etters, numbers & penods

Use my current email address Instead

Password Confirm @
Use 8 or more characters with a mix of letters, numbers &
symbols



https://accounts.google.com/signup/

] Osaan luoda sahkopostitilin - 2

« Osaan viela tehda sahkopostitilini perusasetuksiin mahdollisesti
vaadittavia / tarvittavia lisdasetuksia (syntymapva / kieli, ..)

Win10 / Thunderbird;
Tools > Account Settings: Signature, ..
Tools > Options: Font, Language, ..

Android / Gmail-sovellus
= > {0y > Llanguage

enter




] Osaan ottaa sahkopostini kayttoon

* Osaan valita tarkoitukseeni soveltuvan sovelluksen

* Windows
selain; Firefox, Chrome, Edge, ..
sahkopostisovellus; Thunderbird, ..

* Android
tehdasasennettu sahkdpostisovellus
tai Play-kaupasta valittava ja asennettava muu

* Osaan tehda sahkopostisovellukseen / selaimeen tarvittavia
sahkodpostiasetuksia
* Account Settings; signature, ..
* Tools > Options; font, language
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] Tunnistan luetut ja lukemattomat viestit

*Ymmarran, etta lukematon viesti nakyy postilaatikossani lihavoidulla,
luettu viesti normaalilla fontilla

Re: TeamViewer koulutus etaopastajille 27.8. ®  Nina Ziessler -m_

Re: Opastukset ] Raimo Anttila

&' Re: Maskit opastuksissa ®  Nina Ziessler

) Re: Opastukset o Raimo Anttila

0 % Re: Seniorin digitaidot Reijo Perkiomaki

ENTER ry:n kevatkokous ENTER ry

€ Oodin opastukset syksylla 2020 *  Nina Ziessler

) Re: Opastukset Nikunen, Martti T
ENTER ry:n jasenkirje: lahiopastukset avautuvat syy... ENTER ry

enter




1 Osaan lukea sahkopostiviesteja

* Osaan avata viestin
* kaksoisklikkaamalla (lappari)
» koskettamalla (kannykka)

O TeamViewer koulutus etdopastajille 27.8. - Mozilla Thunderbird = O X
File Edit View Go Message Tools Help

Q Get Messages v # Write ) Chat @ Address Book | © Tag v =

From Nina Ziessler <nina.ziessler@entersenior.fi> ¥ ] Reply -~ Forward (& Archive 0 Junk @ Delete Morev
Subject Re: TeamViewer koulutus etaopastajille 27.8. 7.9.20, 16:18

To undisclosed-recipients:; ¥¢
Bcc Bert @gmail

Heil =

Puolitoista viikkoa sitten pidetyssa TeamViewer perehdytyksessa oli mukana 26 osallistujaa,
kiitos teille ja Tammisen Jukalle!

Lupasin tallenteen tilaisuudesta, se l6ytyy tasta linkista
https://youtu.be/xnNN7WsWC60

enter




] Osaan vastata viestiin

* Jos valitsen 'Vastaa', vastaukseni lahtee vain viestin lahettajalle

* Jos valitsen 'Vastaxgiikille', vastaukseni lahtee myds kaikille muille,
joille viesti minun lisaksi c}’kléhetetty

0 Enterin hallituksen esitykset syyskokouksen asialistassa: kerro kannatatko - Mozilla Thunderbird 22y a X
4 File Edit View Go Message Tools Help

: QGet Messages v # Write ©J Chat @Address Book

4 From Juulia Andersson <juulia.andersson@entersenior.fi> ¥

© Reply O ReplyAlll~v  ~ Forward (3 Archive @) Junk [ Delete MoreV |
Subject Re: Enterin hallituksen esitykset syyskokouksen asialistassa: kerro kannatatko

16.10.20, 13:19 H
To Maarit Fred <maaritfre@gmail.com> W

Cc Reijo Perkiomaki <reijo.perkiomaki@gmail.com> W, Eija Kalliala <eija.kalliala@gmail.com> ¥, Salme Hanski <salmehanski€ 9 more
Kiitos kannatuksestanne.

A?Me nte r entersenior.fi




] Osaan lahettaa viestin edelleen

* Jos valitsen 'Laheta eteenpain’, viesti lahtee henkil6lle, jonka
sahkdpostiosoite kirjoitan-wvastaanottaja-kenttaan

™
0 Enterin hallituksen esitykset syyskokouksen asialistassa: kerro kannatatko - illa Thunderbird aa a X
4 File Edit View Go Message Tools Help

: @Get Messages v # Write [J Chat @Address Book | © Tag v

From Juulia Andersson <juulia.andersson@entersenior.fi> ¥ ) Reply % Reply AII;V ~ Forward (9 Archive 0 Junk @ Delete MoreVv 1

Subject Re: Enterin hallituksen esitykset syyskokouksen asialistassa: kerro kannatatko 16.10.20, 13:19
To Maarit Fred <maaritfre@gmail.com> W

_c Reijo Perkiomaki <reijo.perkiomaki@gmail.com> W, Eija Kalliala <eija.kallisla@gmail.com> #, Salme Hanski <salmehanski€ 9 more
Kiitos kannatuksestanne.
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] Osaan lahettaa viestin

Windows, sahkopostisovellus (Thunderbird)

B Inbox - bertbjardand@gmail.c {

C) Get Messages | v I'Wn[&] CJ chat  §&] Address Book ‘\;

v Cc Becc »

v bert.b}arland@gmatl.col Create a new messageJ o @ From Bert Bjarland <bert.bjarland@gmail.com> bert.bjarland @gmail com
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To | Bert @gmail <bert.bjarland@gmail.com> e Bit View: lncet Fg : " 1=
1 4sw ‘ Ao Spelling v @ Security v [B) Save v
Subject | Test \ s
Sendthismessagenov:'l d <bert biarland® i S el
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facilisis quis. Nullam posuere eros eget pretium imperdiet. Mauris ultrices pulvinar lectus, quis consequat Subject | Test
Parsqraph v Varabie Width v B

justo.|
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) Osaan lahettaa viestin - 2

Bert Bjarland (bert.bjarland@gmail.con

Windows, selain (Firefox)

M Gmail Q  searchma ‘ lorem ipsum .|

O -~ C : 1-190
Compose
i”"l < :
W O v% How-To Geek How to Get a Task Manager Inside PC Gamr
Inbox 6 X
Netflix Kommer pa onsdag 11 november — Befriar
Starred
ENTER ry ENTER ry:n jasenkirje: Seniorin digitaidot -t
Snoozed
Important TED Recommends Bert, your top TED talk recommendation is
New Message — PR
Recipients
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¥ @ % 0O | -

Subject
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) Osaan lahettaa viestin - 3

Android, sahkopostisovellus (Gmail)

& Skriv @ B i

LHCROER Fran  bert.bjarland@gmail.com '.l

Pirkko, harri, Pekka 3 22:07
Ranskantalon tarjouksen hyvaksynta ; Till eBert Bjarland ’

Hei, Téssa on nyt ostajan (Mrs Aranci

&8 Rabskan talo_os...
Test

= Review Geek 21:27 )
EasyPark Facebook "3T*"  The One Where Apple Kicks Intel to ... g Lorem ipsum ..
Read in Browser November 10,2020.. 3
Bert Bjarland
Marjattavagen 14

How-To Geek 19:08 +358405477227

How to Get a Task Manager Inside P...
Did You Know?: While Cookie Monste...

0 ™

Galleri Gmai’ ) m Netflix — CT) ® o \,} * e

Kommer pa onsdag 11 november —...
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] Osaan lahettaa viestin 'pimeasti’

* Jos haluan ettei kukaan vastaanottaja nae, keille muille viesti on myos
lahetetty,

* |ahetan viestin itselleni ja
e laitan kaikki muut vastaanottajat Piilokopio-kenttaan (Bcc)

From Bert Bjarland <bert.bjarland@gmail.com> bert.bjpriand @ gmail.com v Cc »

To  Bert @gmail <bert.bjarland@gmail.com>

Bcc  ole@reform.no  daniel@reform.no  peter.eriksson@haninge.se  marie.persson@hassleholm.se  khalid.rashid@rfsl.se

Subject | ‘Pimes]viesti

Paragraph Vv |  Variable Width v B \ \

TAAAAAS Y AAAAAAAA AAAANANY Al SIS AAAAAAS

enter




J Ymmarran otsikoinnin merkityksen

*Ymmarran, etta otsikon pitaa lyhyesti ja nasevasti kuvata viestin
sisaltda. Vastaanottajahan nakee vain otsikon, ellei avaa viestia.

e Kun vastaan viestiin, tarkistan, etta otsikko vastaa vastaukseni
sisaltoa; jos vastaukseni koskee esim. vain osaa vastaanotetusta
viestista, muotoilen otsikkoa vastaavasti.

e Kun haluaa lahettaa viestin tietylle ryhmalle, poimitaan usein vanha
ryhmalle mennyt viesti, klikataan Vastaa kaikille ja kirjoitetaan uusi
viesti. Ellei muista muuttaa otsikkoa asianmukaiseksi ja mieluummin
pyyhkia vanha sisalto pois, tallainen viesti voi olla vastaanottajille
harhaanjohtava ja turhauttava.

eNnter I ——————




] Osaan avata viestin liitetiedoston

* Avaan liitetiedoston kaksoisklikkaamalla (lappari) tai koskettamalla

0] [Aktiiviset opastajat] Uusin opastajakige on juu... * Paivi Savolainen

Opening Digivinkki_ Aiempien jasenkirjeiden I6ytéaminen (3) (1).pdf X
Enterin opastajat: Syyskuun lopun tilaisuuksia o... * ENTER ry
s w - i i You have chosen to open:
© Reply % Reply Alllv - Forward (3 Archive

Digivinkki_ Aiempien jasenkirjeiden I6ytaminen (5) (1).pdf

ai paivi iorfi> # S
. o S B which is: Portable Document Format (149 KB)
) ot} Utssin apastajadrje on juuri ¥ from: mailbox://
ki pastajat@yhdistysavain.fit¥
Hei opastaja! What should Thunderbird do with this file?

Adobe Acrobat Reader DC v

Huomasithan, ettd Idhetimme &sken teille uuden opastajakirjeen syy
. - NP (O Save File
> [UJ L claTat Digivinkki Aiempien jasenkirjiiden loytaminen (5] (1).pdf Bl

Open the attached file "2 13

PR TREESN ren PR .

[] Do this automatically for files like this from now on.

oK Cancel
Enterin toimintasuunnitelma 2021 hallitukselle ... Juulia Ander:
0] [Aktiivi pastajat] Uusin opastajakirje on juu... * Péivi Savolail

Enterin opastajat: Syyskuun lopun tilaisuuksia o... ENTER ry

© Reply  © Reply All| v - Forward (3 Ar

Frommiba s CavoLainen S pa: Syl iorfi> f Digivinkki: Aiempien jasenkirjeiden Ioytaminen
wubject [Aktiiviset opastajat] Uusin opastajakirje on juuri lahetetty Ovatko Enterin jasenkirjeet joskus hukassa? Tassa voi olla arvokas vinkki:
To entersenior-aktiivisetopastajat@yhdistysavain.fi ¥ Kun I6ydat sahkoposteistasi minka tahansa varikkaan uutiskirjepohjalia
g . Iahetetyn viestin Enteriita, avaa se.
Hei opastaja!

e Klikkaa sahkopostin ylalaidassa "View this email in your browser”

e

Huomasithan, ettd Idhetimme &dsken teille uuden opastajakirjee

> @J 1 attachment: Digivinkki_ Aiempien jésenkirjeiden I6ytdminen (3) (1).pdf 1!
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1 Osaan liittaa tiedoston viestiin

e Lapparilla klikkaan uudessa viestissa klemmarikuvaketta ja valitsen
liitettavan tiedoston, tai

raahaan liitettavan tiedoston kursorilla uuden viestin paalle ja tiputan
sen sinne

* Kannykan sahkopostisovelluksessa kosketan ylalaidassa olevaa
klemmari-ikonia ja valitsen liitettavan tiedoston

* Tiedan, etta myos kuvat ja videot ovat tiedostoja, joita voin lahettaa
liitteena
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1 Osaan tyhjentaa roskakorin ja
-hakemistoja

 Lapparilla klikkaan auki tyopoydalla olevan Roskakori-hakemiston seka
sahkopostisovelluksen hakemistorakenteesta Roskakori- ja
Roskaposti-hakemistot, tarkistan ettei niihin ole vahingossa joutunut
oikeita viesteja ja sen jalkeen valitsen hakemisto kerrallaan hakemiston
koko sisallon ja painan Poista pysyvasti

 Vaihtoehtoisesti valitsen sahkopostin asetuksissa (Junk Settings)
automaattisen tyhjentamisen, jolloin esim. 30 paivaa vanhemmat viestit
havitetaan roskakorista automaattisesti

* Ymmarran, etta kaikki poistetut viestit joutuvat Roskakori-hakemistoon ja
etta jos vahingossa havitan viestin, voin viela |6ytaa sen sielta, niin kauan
kun sita ei ole tyhjennetty

e Kannykan sahkopostisovelluksessa loytaa em. hakemistot ylarivin valikosta

eNnter I ——————




J Ymmarran tietoturvallisuuden perusasiat

* En avaa tuntemattomilta tai epailyttavilta lahettajilta tulleita
* viesteja tai roskapostia
* enka varsinkaan avaa niissa olevia linkkeja tai liitteita

@ Subject o Cerrespondents | ¥ Date
0] Bertbjarland ,K3y kauppaa bitcoineilla ja ansa... © BitcoinGemini 22:41
Varastollamme on (1) pakettia odottamassa... © Jakelukeskus 21:57
Miksi et ole kayttanyt ilmaiskierroksiasi viela? © Nordicspin 21:12
Pyorayta pyoraa ja voit huikeita palkintoja—-... © Bonukset | NordicSpin 19:11
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Palauta seksuaalitaidosi 4 sekunnissa talla klii... © Kliininen parannus - Online-... 14:53
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